
  
PaperPort OneTouch Scanner
Installation Guide

F O R  W I N D O W S



          
C O P Y R I G H T  I N F O R M A T I O N

PaperPort 5.3 Software for Windows. Copyright ©1998 Visioneer, Inc. All rights reserved.

Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws.

AnyPort, AutoFix, AutoLaunch, FormTyper, MicroChrome, PaperEnable, PaperLaunch, PaperPort, PaperPort Deluxe, PaperPort ix, PaperPort Links, 
PaperPort mx, PaperPort PowerBar, PaperPort vx, PaperPortation, PaperPort Strobe, PaperPort 3000, PaperPort 3100B, PaperPort 6000, PaperPort 6000A, 
PaperPort 6000B, PaperPort 6100, PaperPort OneTouch, ScanDirect, SimpleSearch, SharpPage, and Visioneer are trademarks of Visioneer, Inc. PaperPort, 
Paper-driven, and the Visioneer logo are registered trademarks of Visioneer, Inc.

Microsoft is a U.S. registered trademark of Microsoft Corporation. Windows is a trademark of Microsoft Corporation. TextBridge is a registered trademark of 
Xerox Corporation. ZyINDEX is a registered trademark of ZyLAB International, Inc. ZyINDEX toolkit portions, Copyright © 1990–1998, ZyLAB 
International, Inc. All Rights Reserved. All other products mentioned herein may be trademarks of their respective companies. 

Information is subject to change without notice and does not represent a commitment on the part of Visioneer, Inc. The software described is furnished under 
a licensing agreement. The software may be used or copied only in accordance with the terms of such an agreement. It is against the law to copy the software on 
any medium except as specifically allowed in the licensing agreement. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying, recording, or information storage and retrieval systems, or translated to another language, for any 
purpose other than the licensee’s personal use and as specifically allowed in the licensing agreement, without the express written permission of Visioneer, Inc.

Part Number: 05-0359-000

Photo Credits: Tony Martin

Restricted Rights Legend

Use, duplication, or disclosure is subject to restrictions as set forth in contract subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software 
Clause 52.227-FAR14. Material scanned by this product may be protected by governmental laws and other regulations, such as copyright laws. The customer 
is solely responsible for complying with all such laws and regulations.

Visioneer’s Limited Product Warranty

If you find physical defects in the materials or the workmanship used in making the product described in this document, Visioneer will repair, or at its option, 
replace, the product at no charge to you, provided you return it (postage prepaid, with proof of your purchase from the original reseller) during the 12-month 
period after the date of your original purchase of the product.

THIS IS VISIONEER’S ONLY WARRANTY AND YOUR EXCLUSIVE REMEDY CONCERNING THE PRODUCT, ALL OTHER 
REPRESENTATIONS, WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, WRITTEN OR ORAL, INCLUDING ANY WARRANTY OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON- INFRINGEMENT, ARE EXPRESSLY EXCLUDED. AS A RESULT, 
EXCEPT AS SET OUT ABOVE, THE PRODUCT IS SOLD “AS IS” AND YOU ARE ASSUMING THE ENTIRE RISK AS TO THE PRODUCT’S 
SUITABILITY TO YOUR NEEDS, ITS QUALITY AND ITS PERFORMANCE,

IN NO EVENT WILL VISIONEER BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
RESULTING FROM ANY DEFECT IN THE PRODUCT OR FROM ITS USE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

All exclusions and limitations in this warranty are made only to the extent permitted by applicable law and shall be of no effect to the extent in conflict with the 
express requirements of applicable law.

FCC Radio Frequency Interference Statement 

This equipment has been tested and found to comply with the limits for the class B digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy and if not installed, and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equirpment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help.

This equipment has been certified to comply with the limits for a class B computing device, pursuant to FCC Rules. In order to maintain compliance with 
FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded cables is likely to result in 
interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the approval of manufacturer 
could void the user’s authority to operate this equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, 
and (2) this device must accept any interference received, including interference that may cause undesired operation.



                                  
WELCOME

Congratulations on purchasing your Visioneer PaperPort OneTouch 
flatbed color scanner. By pressing a single button on the scanner, you 
can scan and print, scan and fax, scan and open the PaperPort software, 
or scan and open many other software applications on your computer.

WHAT’S IN THE BOX

Before starting the installation, check the contents of the box to make 
sure that all parts are included. If any items are missing or damaged, 
contact the dealer where you purchased the scanner.

▼ NOTE: The CD also includes the PaperPort User’s Guide, the manual 
for the PaperPort software. You can print a copy of the manual from 
the CD to your printer.

Software CD Installation Guide Power cord Scanner cable

PaperPort OneTouch Scanner
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WHAT YOU NEED 

To use the scanner and software, you need the following:

■ IBM PC (or 100-percent compatible) Pentium or higher

■ Microsoft Windows 95 or Microsoft NT 4.0 

■ 16 megabytes (MB) or more of available internal memory (RAM)

■ 35 MB of free hard disk space

■ A VGA or SVGA monitor. Recommended monitor setting for color 
is as many colors as possible—High Color (16-bit), True Color 
(24-bit), or 32-bit if your monitor has that capability. Set resolution 
to at least 800 by 600 pixels. To set colors and resolution, open the 
Windows Control Panel, double-click Display, and click Settings.

■ A CD-ROM drive

GETTING THE PAPERPORT USER’S GUIDE

The CD also includes your PaperPort User’s Guide. This guide provides 
more detailed information about PaperPort’s features. Please see the CD 
to view or print the guide. The guide is also available at Visioneer’s web 
site at www.visioneer.com.

GETTING HELP

The PaperPort software includes a complete set of help topics that 
answer questions about the scanner and its software.

To get help while using the PaperPort software:

■ Press the F1 key, or from the Help menu, choose PaperPort Help 
Topics to display the Help Topics window. The help topics cover the 
PaperPort software and the OneTouch scanner.

▼ TIP: If you don’t find the answers in the help or User’s Guide, see the 
technical support card that you received with your scanner.



 

T

 

HE

 

 O

 

NE

 

T

 

OUCH

 

 S

 

CANNER

 

3

        
THE ONETOUCH SCANNER

7

Glass

Document pad

8

5

4

3

2

1

Reference frame

Document cover

To printer

Power jack

To PC parallel 

Five-Button panel

6

1 Document cover. Close the document cover after placing items on the scanner glass.

Document pad. Helps to secure the document in place on the scanner glass.

Glass. Place items face down on top of the glass, in the upper left corner.

Reference frame. Place items face down within this frame. Both inches and centimeter 
markings appear along the border of the frame.

Five-Button panel. Press a OneTouch button to scan, print/copy, fax, convert items to text, 
or scan and open PaperPort-supported applications on your computer.

Power jack. Plug the scanner power cord into this jack.

To PC parallel. Plug the cable that connects the scanner to the computer into this port.

To printer. Plug your printer cable into this port.

6

5

4

2

3

▼ NOTE: The scanner does not have an on/off switch. The power is 
on as soon as you start your computer.
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STEP 1: CONNECTING THE SCANNER TO THE COMPUTER

The PaperPort OneTouch scanner connects to any available parallel 
(LPT) port on the back of your computer.

▼ NOTE: Please follow the sequence of steps in this section. Do not 
connect the power cable until all other connections are complete.

To connect the PaperPort scanner: 

1. Save any open files, and then shut down Windows.

2. Turn off the power to your computer. 

3. Slide the scanner lock to the unlocked position. The lock holds the 
scanner head securely in place to protect it from damage during 
shipping.

The lock is on the bottom of the scanner, as shown in the following 
figure. Your scanner may be slightly different than the one shown in 
the figure.

Locked position

Unlocked position

Unlocked position

Locked position
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▼ NOTE: If you transport a locked scanner, remember to unlock it 
prior to scanning. Failure to unlock it may damage the scanner.

4. If a printer cable is attached to your computer’s parallel port, 
unplug the cable and plug it into the port marked “To printer” on 
the back of the scanner.

5. Plug the PC end of the scanner cable into an available parallel port 
on the back of your computer. 

On some older computers the serial port and parallel port both 
have 25-pin connectors that fit the scanner cable. Please make sure 
you plug the scanner cable into a parallel port.

6. Plug the other end of the scanner cable into the port on the back of 
the scanner marked “To PC parallel port.”

7. Plug the power adapter cable into the jack on the scanner.

8. Plug the power adapter into an AC (wall) outlet. The power-on 
light on the front of the scanner comes on indicating the scanner is 
receiving power.

The following diagram shows the cable connections.

9. Turn on your computer. You’re now ready to install the software.

▼ NOTE: The scanner’s power-on light remains lit when the computer 
is turned off. This is normal even though the computer is turned off. 
To conserve electricity and prolong the life of the scanner, the 
scanning lamp automatically powers down when you aren’t scanning.

Printer cable

Power cord

Scanner cable
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STEP 2: INSTALLING THE PAPERPORT SOFTWARE

The PaperPort CD includes all the PaperPort software files.

▼ NOTE: The CD also includes the PaperPort User’s Guide, the manual 
for your PaperPort software. You can read the guide while the CD is 
running, or print a copy directly from the CD.

To install the PaperPort software:

1. Start Microsoft Windows and make sure that no other applications 
are running.

2. Insert the PaperPort CD into your computer’s CD-ROM drive. 
The CD automatically starts.

▼ NOTE: If the PaperPort CD does not automatically start, make sure 
the CD drive’s door is completely shut. If the CD still doesn’t start, 
click the Windows 95 icon that shows the drives on your computer. 
(Usually, the icon is named My Computer.) The window shows the 
drives available on your computer. Double-click the icon for your 
CD-ROM drive to see the list of files on the CD. Double-click the 
file named START32.EXE. The CD starts. 

3. Click the PaperPort Software button and follow the instructions 
on the screen. 

After the PaperPort software is installed on your computer, you can 
click the appropriate buttons on the CD to install the other 
applications provided on the CD, or read and print the PaperPort 
User’s Guide documentation.

4. When you’re finished installing the software, remove the CD from 
the CD drive.
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STEP 3: CHECKING IT OUT

The OneTouch scanner software adds the scanner icon to the Windows 
taskbar (at the bottom right corner of the computer screen). If the 
scanner icon looks like the one shown in the figure, the scanner is 
properly connected.

If the icon has a red X through it, the scanner is not properly connected. 
Please see the next section, “If the Scanner Is Not Properly Connected,” 
for the steps to fix the problem.

To check the status of the scanner:

1. Place the mouse pointer on the scanner icon on the Windows 
taskbar.

2. Click the icon with the right mouse button.

The shortcut menu appears.

3. Choose About from the shortcut menu.

A dialog box confirms that the scanner is connected properly.

Scanner Icon
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4. Click OK to close the dialog box.

That’s it. Your OneTouch Scanner is ready to scan.

See “Scanning By Pressing the OneTouch Buttons” on page 12.

IF THE SCANNER IS NOT PROPERLY CONNECTED

If the scanner icon on the Windows taskbar has a red “X” through it as 
shown in the figure, the scanner is not properly connected.

Check the following possible problems:

■ Is a cable loose or not plugged in securely? Inspect all cable 
connections. Make sure all the cables are plugged in securely.

■ Is the scanner’s power light on? If it isn’t, plug the power adapter 
into another electrical outlet.

■ Are you using an older computer that has 25-pin connectors for both 
serial and parallel ports? You may have plugged the scanner cable 
into a serial port instead of the parallel port. Remove the scanner 
cable from the serial port and plug the cable into the parallel port.

■ Are other devices “daisy-chained” to the parallel port? If so, the 
scanner must be the first one connected to the computer (with 
the exception of a Zip drive which must be connected directly to 
the computer and the scanner then connected to the drive). 
Plug the scanner into the computer’s parallel port first, then plug 
the next device into the scanner.

■ Did you restart the computer after installing the software? If you 
didn’t restart the computer, it may not have loaded all of the 
software files. Try restarting your computer.

Please see the Readme file on the CD for additional information that 
may help you diagnose problems connecting the scanner.
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To connect the scanner:

1. After checking all of the above problems, place the mouse pointer 
on the scanner icon with the red X over it and click the right mouse 
button.

The shortcut menu appears.

2. Choose Connect from the shortcut menu.

The software finds the scanner and makes the connections. 
The scanner icon will no longer have a red X through it, and you’re 
ready to begin scanning.

If you try all the troubleshooting procedures described above and in the 
Readme file, and the scanner icon still has a red X through it, you may 
have a malfunctioning scanner. Please see the technical support card 
that you received with your scanner for the numbers to call to receive 
technical assistance.
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ABOUT THE ONETOUCH BUTTONS

The OneTouch buttons are pre-configured to scan items at various 
settings, and then send the scanned image to a pre-selected software 
application. You can change the settings for each button except the 
Stop/Cancel button. See “Changing the Button Settings” on page 14.

The following table lists the pre-configured settings of the scanner 
buttons:

▼ NOTE: If a button is not pre-configured—for example, if your 
computer does not have fax software installed so the fax button 
cannot be pre-configured—a dialog box appears to remind you to 
configure that button manually.

Button Pre-Configured Settings

Scan Displays the scanned item in PaperPort
Scan setting: Color—fast mode
Resolution: 100 dpi

Copy/Print Prints the scanned item on Printer/Copier
Scan setting: Black and white
Resolution: Your printer’s or copier’s default 
resolution

Fax Displays the scanned item in your Fax software
Scan setting: Black and white
Resolution: Your fax machine’s default resolution

Custom Converts the item’s text to word processing text and 
displays the text in Windows Notepad
Scan setting: Black and white
Resolution: 300 dpi

Stop/Cancel Cancels the scan in progress.
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THREE WAYS TO SCAN

You can scan items by pressing a button on the scanner, clicking a 
button on the screen, or by using the PaperPort software.

■ Scan with the Scanner Buttons 

Press a OneTouch button on the scanner’s front panel.

■ Scan from the Screen

Click the scanner icon on the Windows taskbar. A panel representing 
the scanner buttons appears. Click a button on the panel on the 
screen.

■ Scan from the PaperPort Software

Start the PaperPort software, and click the Twain icon on the 
PaperPort Command Bar.

The PaperPort Scan Manager appears so you can Preview the scanned 
image, make any adjustments, and then scan the final image to the 
PaperPort Desktop. See “Scanning from the PaperPort Software” on 
page 20 for details.



12 PAPERPORT ONETOUCH SCANNER INSTALLATION GUIDE
SCANNING BY PRESSING THE ONETOUCH BUTTONS

Pressing a scanner button scans the item and then sends the image either 
to the printer to print, or to a software application on your computer.

To scan with a OneTouch button:

■ Place an item to scan on the glass, face down, and press one of the 
scanner buttons.

The scanner starts scanning the item. A message on the Windows 
taskbar shows the destination application of the scanned image. In 
the sample below, the scanned image will appear in Microsoft Paint.

A window on the screen also shows the progress of the scanning as 
illustrated by this example of a photograph being scanned:

When the scan is complete, the scanned image appears in the 
destination software.
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SCANNING FROM THE SCREEN

Scanning from the screen is just like pressing a scanner button, except 
you click the button on the screen. The scanner scans the item and then 
sends the image either to the printer to print, or to a software 
application on your computer. This method of scanning is especially 
helpful if the scanner is not located close to your computer.

To scan from the screen:

1. Place an item to scan on the glass, face down, and click the scanner 
icon on the Windows taskbar.

The scanner button panel appears on the screen.

2. Click the button you want to use to scan. 

Clicking a button on the screen scans the item just like pressing a 
button on the scanner.

The scanner starts scanning the item, the messages about the 
scanning appear in the Windows taskbar, and the progress window 
shows the image as it is scanned. When the scan is complete, the 
scanned image appears in the destination software.
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CHANGING THE BUTTON SETTINGS

Each button setting can be changed to optimize the scanner for the type 
of scanning you want to do.

To change a button’s settings:

1. Press and hold down the button that you want to change (except the 
Stop/Cancel button). The scanner beeps several times.

The Preferences dialog box appears. The tabs on the dialog box 
correspond to the buttons (except Properties).

The selections on the dialog box show the current settings for the 
button. For example, the following figure shows a sample of current 
settings for the Custom button because the Custom tab is selected.

In this sample, the Custom button is set up to scan the item with 
the configuration named Editing Text (OCR) Accurate, and then 
after the scanning is finished, to open Microsoft WordPad to 
display the converted text of the scanned image. 
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2. Click the tab of the button you want to change, if it isn’t already 
selected.

3. Scroll the list of Application to Send Scanned Data To and click the 
new application you want to use to view and work with the scanned 
image.

▼ NOTE: If you select a word processing program such as Microsoft 
WordPad or Microsoft Word and a configuration for OCR, the text 
in scanned images is automatically converted to word processing text 
by the optical character recognition (OCR) software that you receive 
with the scanner. The converted text then appears in the selected 
application.

4. Click a selection in the Configuration to Use list to choose a new 
scan setting for the selected scanner button.

The configurations in the list are preset for the application you 
select in the application list. If you select another application, the 
configurations are for that application.

Select a software 
application to 
send the scanned 
image to that 
application.

Select a setting 
for scanning the 
item.

Select options for 
the button.
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To see the settings for a configuration, select it and click the Edit 
button. See the section “Adjusting a Button’s Scan Settings and Page 
Settings” on page 17 for more information.

If you want to select a configuration prior to scanning, click the 
option, Configure before Scanning. Then, when you press a scanner 
button, the PaperPort Scan Manager appears first and you can select 
a configuration before scanning. See “Scanning an Item” on page 21 
for more information about the Scan Manager.

5. Select the Scanner Button Options for the button.

6. Click OK.

Now when you press the scanner button, it scans the image using 
the new configuration settings and displays the scanned image in 
the new application.

▼ NOTE: The Preferences dialog box is also available from the scanner 
icon on the Windows taskbar. Click the icon with the right mouse 
button, then choose Preferences from the shortcut menu. The panel 
representing the scanner buttons appears. Click a button on the 
panel with the right mouse button (don’t click with the left mouse 
button; clicking with the left mouse button starts scanning). A dialog 
box shows the current settings. Click the Edit button on that dialog 
box. The Preferences dialog box appears.

SELECTING PROPERTIES

Clicking the Properties tab on the Preferences dialog box displays a list 
of options and settings for customizing the scanner, and provides a 
direct link to Visioneer’s web site. Please see the Help information for a 
complete description of the Properties.

GETTING HELP WITH THE ONETOUCH BUTTONS

The software for scanning with the OneTouch buttons includes Help 
information. That information describes each feature of the software 
and answers questions about the how to configure the buttons for the 
best scanning. 
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To get help with the OneTouch buttons:

■ Click the Help button on the Preferences dialog box or on the other 
dialog boxes that you use to select options for the OneTouch buttons.

ADJUSTING A BUTTON’S SCAN SETTINGS AND PAGE SETTINGS

You can adjust a button’s scan settings and page settings for the item 
being scanned. For example, if the scanned image is too dark, you can 
adjust the brightness of the setting.

To adjust a button’s scan settings and page settings:

1. Press and hold down a button on the scanner. 

The Preferences dialog box appears.

The selected tab on the dialog box corresponds to the button you 
want to adjust. You can click another tab to adjust a different 
button.

2. In the Configuration to Use list, click the configuration that you 
want to adjust.

3. Click the Edit button.

The dialog box for adjusting the scanning appears.
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Mode—Select Black/White to scan in black and white. 
For example, letters and memos are usually scanned in black and 
white. Select Grayscale to scan items such as documents containing 
drawings or black and white photographs. The scanning produces 
an image in varying shades of gray. Select Color to scan color 
photographs and other color items.

Resolution—Drag the slider to the right or left to adjust the dots 
per inch (dpi) of the resolution. The maximum resolution is 
600 dpi, the minimum is 50 dpi. The higher the dpi setting, the 
sharper and clearer the scanned image. However, higher dpi settings 
take longer to scan and produce larger files for the scanned images.

Brightness and Contrast—Drag the sliders to the right or left to 
adjust the brightness and contrast of the scanned image.

4. Click the Page Settings tab to adjust the scan page settings.

Page Size—Choose one of the page sizes from the drop-down list. 
The boxes on the picture on the right illustrate the selected page 
size.
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AutoCrop—Select this option to automatically fit the page size to 
the size of the scanned image. The result is that the scanned image 
fills the entire page. When scanning with this option selected, you 
can put the item anywhere on the glass. The scanner makes two 
passes over the item on the glass—the first pass senses the item’s size, 
and the second pass scans the image and crops the page size to 
match the image size. This option overrides the Page Size menu 
selection.

DeScreen—Select this option when scanning a newspaper or 
magazine article, or other item that contains images with patterns 
or dots. Scans of patterns or dots sometimes have a distorted or 
wavy appearance. The scanner scans the item to compensate for the 
patterns and dots, and produces a clearer image. The scanning may 
slow down a bit when this option is selected. You don’t need to 
select this option when scanning photographs.

Gamma—Drag the slider to adjust the range of tones to emphasize 
in an image. Typically used for an image that is dark or that has 
darker areas, increasing the gamma brings out details in the 
shadows or dark areas. Decreasing the gamma produces better 
image quality in the lighter, highlighted areas of the scanned image.

5. Click OK.

The Preferences dialog box reappears. 

6. Click OK on the Preferences dialog box. 

The adjusted settings now apply to the button.

▼ NOTE: If you select the Copy/Print or Fax button, the dialog box 
for editing and adjusting the settings will have a Device tab for 
selecting options for a printer or copier. See the Help for more 
information.
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SCANNING FROM THE PAPERPORT SOFTWARE

Instead of using the OneTouch scanner buttons, you can scan directly 
from the PaperPort software. This is particularly helpful when you’re 
using PaperPort to file and save your scanned items.

To scan from PaperPort, you must first do a one-time-only set up of the 
software.

To set up the PaperPort software with the scanner:

1. If the PaperPort software isn’t currently running, double-click the 
PaperPort icon on the Windows desktop to start it. The PaperPort 
Desktop appears. 

2. From the File menu, choose Select Source. The Select Source 
dialog box appears, listing your PaperPort OneTouch scanner 
(as well as all other TWAIN devices installed on your computer).

3. Choose the Visioneer OneTouch scanner option, then click Select.

▼ NOTE: You don’t need to set up the scanner again unless you change 
the source to some other TWAIN device, such as a digital camera.
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SCANNING AN ITEM

The following procedure provides the basic steps for scanning an item. 
You can scan many types of items, from small business cards to A4-sized 
pages. The PaperPort software also has special settings for scanning color 
photos and fine print (like the fine print on a contract). For more 
information about scan settings, see “Adjusting Scan Settings in 
PaperPort” on page 23.

To scan an item:

1. Open the scanner cover, place the item face down onto the upper 
left edge of the scanner glass, and close the cover.

2. If PaperPort isn’t running, double-click the PaperPort icon on the 
Windows Desktop to start it. The PaperPort Desktop appears. 

3. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. 

4. The PaperPort Scan Manager dialog box appears.

5. Click the Preview button on the Scan Manager dialog box. 

The scanner scans the item and displays a preview. You use the 
Preview feature to make sure the image is correct before scanning 
the item as a final image.

The following figure is a sample of the Scan Manager dialog box.
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6. Click one of the Scan Page For options. For example, if the item is a 
black and white newspaper article that you want to save, select the 
setting for scanning text to file (Faxing, Filing, or Copying). 
For more information about these settings, see “Adjusting Scan 
Settings in PaperPort” on page 23.

7. To reduce the size of the area the scanner scans, drag the selection 
rectangle around the item or click one of the predefined scan area 
icons.

▼ NOTE: For more details about the Scan Manager’s features, choose 
PaperPort Help Topics from the Help menu.

8. (optional) To see a preview again before scanning the final image, 
click the Preview button. Readjust the settings if necessary.

Select an option 
appropriate for how 
you want to use the 
scanned item.

Adjust the brightness or 
contrast of the scanned 
item.

Set the measurement 
units to view the
dimensions of the 
preview item.

View and adjust the scan 
settings.

Restore the default 
settings.

Preview the item 
here. 

Use predefined area 
icons to select the area 
of an item to scan.

The Auto icon is the default. 
It selects the entire item to scan.

Scan the item to the 
PaperPort Desktop.

Preview the item 
before you scan.

Drag the borders of 
the selection rectangle 
surrounding the item 
to adjust the area that 
the scanner scans.
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9. When you’re satisfied with the image settings, click the Scan 
button. 

The scanner now re-scans the item and displays the final image as a 
thumbnail on the PaperPort Desktop.

 

Please see the PaperPort Getting Started Guide and PaperPort User’s Guide 
on the CD for more information about using the PaperPort software.

ADJUSTING SCAN SETTINGS IN PAPERPORT

You can adjust the scan settings for scanning from within PaperPort to 
fine-tune the scanned item. This section tells you how to:

■ Select a predefined scan setting.

■ Customize a scan setting.

■ Scan in color.

■ Adjust the brightness and contrast.

■ Select the area of the item you want to scan.

Thumbnail
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SELECTING A PREDEFINED SCAN SETTING

Selecting the proper scan setting before final scanning provides the best 
results for a scanned item. The scan setting determines the sharpness of 
the item and the number of possible shades of gray or color. 
These selections also affect the speed of the scan and the file size.

In the PaperPort Scan Manager dialog box, you can select one of the 
predefined scan settings described in the following table. 

Scan Page For Default Setting To Scan Description

Faxing, Filing, 
or Copying

Black-and-white
200 dpi

Newspaper and 
magazine articles, 
receipts, forms, and 
other text items

Provides the fastest scan time 
and smallest file size.

Editing Text 
(OCR)

Black-and-white
300 dpi

Business letters, 
contracts, memos, and 
other documents that 
you want to edit

Enhances the use of OCR 
software for converting item 
text to editable text. Provides 
higher quality and a larger file 
size than the Faxing, Filing or 
Copying scan setting. 

Black & White 
Photo

Grayscale
100 dpi

Black-and-white 
photos

Provides the best setting for 
black-and-white photos.

Color Photo—
Faster

Color
100 dpi

Color pages with 
many graphics, or 
mixed graphics and 
text, line art, or 
photos that require a 
quick scan

Creates a reasonable scanned 
color item in a file that is not 
too large. PaperPort’s default 
setting.

Color Photo—
Better Quality

Color
300 dpi

Photographs and 
color items

Provides the ideal setting for 
color items, item editing, 
desktop publishing, and high-
quality output. Results in a 
color scan with slower scan 
time and a larger file size. 
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To select a scan setting:

1. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. 

The PaperPort Scan Manager dialog box appears. 

2. In the Scan Page For options, select the scan setting appropriate for 
the item you want to scan. For example, to scan an article that you 
want to fax, choose the Faxing, Filing, or Copying setting.

3. To see the details of the scan setting, such as the bit depth and 
resolution, click the Advanced Settings button. The Advanced 
Settings dialog box appears.

4. Click OK to return to the PaperPort Scan Manager dialog box.

CUSTOMIZING A SCAN SETTING

You can customize a predefined scan setting or create a new custom scan 
setting. 

▼ TIP: At any time, click the Restore Defaults button to restore the 
original predefined scan settings.

To customize a scan setting:

1. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. 

The PaperPort Scan Manager dialog box appears. 

2. In the Scan Page For options, select a predefined scan setting to 
modify a setting, or select Custom to create a new scan setting.

3. Click the Advanced Settings button. The Advanced Settings dialog 
box appears.

4. Select your choices for item type, resolution, gamma, and name.

5. Click OK to return to the PaperPort Scan Manager dialog box.
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SCANNING IN COLOR

Your PaperPort OneTouch scanner is initially set to scan from the 
PaperPort software with the setting Color Photo—Faster. To scan at a 
higher resolution, select Color Photo—Better Quality. 

▼ NOTE: Scanning at a higher resolution creates a larger file size and 
takes longer to scan. To minimize the file size and the time required 
to get a better quality scan, select just the area of the item that you 
want to scan. For more information about selecting the area of an 
item, see “Selecting the Area of the Item You Want to Scan” on 
page 27.

To scan in color:

1. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. 

The PaperPort Scan Manager dialog box appears. 

2. Click Color Photo—Faster or Color Photo—Better Quality. 
You can also use these settings for any other color items such as 
color pages from articles. 

3. Scan the item in the normal manner.

ADJUSTING THE BRIGHTNESS AND CONTRAST

Sometimes an item is scanned with the brightness and contrast set to be 
too light or too dark. For example, a note written with a light pencil 
may need to be scanned darker to improve legibility. 

You can adjust the brightness and contrast at which grayscale and color 
items are scanned. You can also adjust the brightness for black-and-
white items. If an item is currently displayed in the preview area, the 
changes you make using the Brightness and Contrast control bars are 
reflected in the preview item. 
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To adjust brightness and contrast:

1. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. 

The PaperPort Scan Manager dialog box appears. 

2. Drag the Brightness slider to the left to make the item darker or to 
the right to make the item lighter. When you release the mouse 
button, the change is reflected in the preview item.

3. Drag the Contrast slider to the left to decrease the contrast or to the 
right to increase the contrast. When you release the mouse button, 
the change is reflected in the preview item.

SELECTING THE AREA OF THE ITEM YOU WANT TO SCAN

By default, the PaperPort software automatically scans an entire item 
placed on the scanner. However, you may want to select only a certain 
area of an item to scan. Selecting an appropriate scan area can result in a 
faster scan and a smaller file size. 

To select the area you want to scan, you can use the predefined scan area 
icons or manually select an area. For example, if you have a photo that is 
letter size, but you want to scan only an area approximately 6 x 8 inches, 
you can use the A5 icon to set these dimensions for you. The Predefined 
scan areas are:

■ Auto—Automatically sets the entire item as the scan area. By default, 
Auto is selected.

■ Card—Scans an area 4 x 2.5 inches (10.2 x 6.4 cm), equivalent to an 
average business card.

■ A5—Scans an area 5.8 x 8.3 inches (14.8 x 21 cm).

■ B5—Scans an area 7.2 x 10.1 inches (18.2 x 25.7 cm).

■ Letter—Scans an area 8.5 x 11 inches (21.6 x 27.9 cm).

■ A4—Scans an area 8.3 x 11.7 inches (21 x 29.7 cm).

If you don’t select an icon, Auto is automatically selected. You can also 
manually select the area that is scanned by dragging the borders 
surrounding the preview image to reduce or enlarge the area.
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To select the area you want to scan:

1. Put the item on the scanner glass and close the cover. 

2. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. 

The PaperPort Scan Manager dialog box appears. 

3. Click the Preview button. An image of the scanned item appears in 
the Preview area. By default, the Auto icon is selected, and a 
selection rectangle surrounds the entire item.

4. (optional) In the Scan Area settings, select the units of measure you 
want to use for the scan area. You can select either inches, 
centimeters, or pixels.

(optional) To use a scan area icon other than Auto, click one of the 
predefined scan area icons, such as A4 or Card, in the Preview area. 
A selection rectangle reflecting the measurement of the selected scan 
area icon appears. For example, if you click the Letter icon, 
a rectangle that is 8.5 x 11 inches appears.

5. Drag the rectangle to position it over the area you want to scan. 

6. To change the dimensions of the rectangle, click the rectangle, and 
then drag the borders of the rectangle to resize it. This effectively 
allows you to crop the item. The dimensions of the selected area 
appear in the Scan Area settings.

7. When you’re satisfied with the new scan area, click the Scan button.

CLEANING THE SCANNER GLASS

Scanning items that have excessive amounts of dirt or dust may dirty the 
glass. To ensure the best quality scanned item, wipe the scanner glass 
with a soft clean cloth to rid the glass of dust or other debris.
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PAPERPORT SCANNER SPECIFICATIONS

Bit Depth 36-bit color (24-bit output)
12-bit grayscale
1-bit line art

Scanning resolution Optical resolution: 
600 x 1200 dpi

Maximum resolution (interpolated):
2400 x 2400

Maximum Item sizes 8.5 x 11.69 inches (21.6 x 29.7 cm)
Operating Systems Windows 95

Windows NT 4.0
Scanner dimensions

Height 3.2 inches (8.2 cm)
Width 12 inches (30.6 cm)
Length 16.3 inches (41.4 cm)

Weight 8.3 pounds 
Operating temperature 50°–104° F (10°–40° C)
Relative humidity 20%–80%
Power supply

Input voltage/frequency 100 Vac, 50/60 Hz (Japan)
120 Vac, 60 Hz (North America)
230 Vac, 50 Hz (Europe)

Output voltage/watt 12 V DC, 15 watt maximum
Safety and agency certifications UL, ULc, GS, FCC Class B, 

VCCI Class 2, CE
Hardware warranty One-year limited warranty
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